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INTRODUCTION 

I f you thought that taping old movies or making videos of your family and 

friends was fun, wait until you start using VCR Companion to customize your 

videos with that professional touch! 

SIMPLE VCR HOOK-UP 
By connecting your Apple computer to your VCR with a simple hook-up, you can 
use VCR Companion to add titles, credits, intermissions, animations and special 
effects such as "fade-ins" and "wipes" to your videos. 

Videos you took of your vacation, birthday parties, family occasions and other 
events can now be transformed into professional-looking videotape productions. 
You will probably even discover new uses for your expensive video equipment! 

OR JUST USE YOUR COMPUTER 
If you don't have a VCR, you can create exciting video presentations using just your 
computer and then create a self-booting FilmDisk on which to store them. 

When creating video presentations for use with a FilmDisk, VCR Companion 
allows you to combine text, animation and full-screen artwork to create a business or 
educational presentation, a unique type of on-screen greeting or message, a 
self-running, eye-catching sales pitch for store windows and much more. 

THOUSANDS OF EASY-TO-USE GRAPHIC COMBINATIONS 
VCR Companion presents all its many features and options in a very straightfor
ward system of menus. You simply select from these menus using your computer 
keyboard, a mouse or a joystick. 

VCR Companion comes complete with plenty of fonts, graphics, borders, 
transitions, special effects and animations which may be combined in countless 
ways and are sure to stir your creative imagination. When your video productions 
demand even more than what's included in th~ program, you may want to check out 
Bn;;derbund Software's VCR Companion Film Library, an additional collection of 
exciting graphic elements. 

If you like to design your own artwork, VCR Companion allows you to import 
artwork and animations from your favorite graphic software simply and easily. For 
example, you can use such great Br0derbund products as Dazzle Draw to create 
background pictures, Fantavision to create movies and Animate to create special 
animation "characters." 

And now, could we have quiet on the set, please ? You're in the director's chair, 
VCR Companion is ready to roll and ... Action! 
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USING THIS MANuAL For easy reading and reference this manual is divided into the following sections: 

Getting 
Started 

Quick Start 

Using Your 
VCR 

Makinga 
FihnDisk 

Working 
with VCR 
Companion 

Utilities 

Creative 
Ideas 

Appendix 

Index 

Describes the equipment you'll need and explains how to start 
up the program, install it on your hard disk and obtain a backup 
copy or a 3.5-inch disk version. 

Gets you started on your first video script with an easy to 
follow tutorial. The procedures you'll learn in this tutorial will 
give you a comprehensive understanding of how to operate all 
of VCR Companion's many options and features. 

Explains how to connect your VCR to your computer and how 
to record your VCR Companion video scripts. 

Shows how to use VCR Companion to create self-booting 
"FilmDisks" on a computer floppy disk. (No VCR is required. ) 

Summarizes the options and features discussed in the Quick 
Start tutorial and introduces a few new ones: adding graphic 
icons to your video scripts, using "Readymade" scripts and the 
Save and Load commands. 

Describes VCR Companion's utility programs for importing 
artwork and further customizing your video scripts. 

Offers lots of suggestions for using VCR Companion. 

Includes further technical information you may find useful. 

Gives you a complete reference index. 
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GETTING STARTED 

T his section describes the equipment you'll need to use VCR Companion 
and how to start up the program, how to install it on your hard disk and 

how to obtain a backup copy or a 3.5-inch disk version. 

WHAT YOU'LL NEED • an Apple Ile®, Ile® or Iles® with at least 128K of memory 

• one disk drive 

• a monochrome or color monitor or a television 

• a VCR, any format* 

• a videotape (either blank or with a recording that you want to customize)* 

• an RCA cable (useful for hooking up your VCR) 

OPTIONAL 

• a mouse or joystick 

• a second disk drive (for optimum performance) 

• blank floppy disks on which to save scripts and make "FilmDisks" 

• VCR Companion Film Library for additional artwork, fonts , effects and transitions 

• artwork or animations on disk that you have already created using Dazzle 
Draw, Fantavision or Animate 

* Since VCR Companion can be used with or without a VCR, the VCR is really 
an optional piece of equipment. However, having a VCR will add so much to the 
enjoyment of the program that we assume most people will want to use one. 

STARTING UP ~ 1. Insert VCR Companion Side 1 into the disk drive. 

THE PROGRAM Insert the disk into the disk drive label side up and close the drive door. 

INSTALLING 
VCR COMPANION 
ON A HARD DISK 

~ 2. Tum on the monitor and computer. 

The program will load automatically. In a few seconds the title screen will 
appear on screen followed by the Main Menu. 

The following instructions for installing VCR Companion on a hard disk require 
that you have a very basic understanding of such ProDOS® conventions as 
"folders." If this is not the case, please refer to the Appendix of this manual 
under the heading "VCR Companion and ProDOS." If you need even more 
information on the subject of ProDOS, please refer to the ProDOS manual itself. 



T 

-

OBTAINING A BACKUP OR 
3.5-INCH DISK COPY 

If you require some preliminary instruction on selecting options within VCR 
Companion before proceeding, please tum to page 8 of this manual. 

To install VCR Companion on a hard disk: 

.,.. 1. Select Utilities from the Main Menu . 

.,.. 2. Select Install Onto Hard Disk from the Utilities menu. 

Transition Edlfor --
ConPert Graphics 

Install Onto Hard Disk 

Then, from the Hard Disk Install menu that appears simply follow the 
prompts to: 

.,.. 3. Select Hard Disk as the copying destination . 

.,.. 4. Create a folder for VCR Companion . 

.,.. 5. Insert disk Sides 1, 2, 3 and 4 of VCR Companion when prompted. 

Note: To load VCR Companion from the hard disk simply execute the 
VCRC.SYSTEM file in the folder you created. 

The 5.25-inch VCR Companion master program disks may be exchanged for a 
3.5-inch disk copy. You may also obtain a backup copy for archival purposes in 
either format. Forms and instructions for ordering your backup disk may be found 
in the Appendix of this manual. For information on ordering a 3.5-inch disk 
version, call Broderbund Software-Direct at 800/527-6263 or 415/492-3500. 



QUICK START 

SELECTING ITEMS FROM 
VCR COMPANION MENUS 

TUTORIAL: YOUR FIRST 
VIDEO SCRIPT 

T his section is designed to quickly get you up and running with VCR 
Companion. It explains how to select menu items and provides an easy

to-follow tutorial for making "Your First Video Script." Instructions for 

connecting and using your VCR follow in the next section. 

All the menus in VCR Companion work in a similar way, presenting options you 
may select by using a mouse, a joystick or the keyboard arrow keys. 

Using a 
Mouse 

Using a 
Joystick 

Using the 
Keyboard 

Move the mouse to position the on-screen pointer over the 
desired menu option. Press once on the mouse button to make 
your selection (referred to as "clicking" the mouse). 

Push the joystick up, down, left or right to position the on
screen pointer over the desired menu option. Press either of 
the buttons on the joystick to make your selection. 

Use the left, right, up and down arrow keys to move the 
pointer over the desired menu option. Once the pointer is 
positioned over your selection, press the Return key. 

Note: You can use the Esc key to backtrack from most screens and menus 
without making a selection. Pressing the Esc key, mouse button or joystick 
button while a video script is running in Preview or Record will stop further 
loading of the video script and return you to the Edit Script screen. 

The following step-by-step tutorial shows you how to create the opening title 
footage for a vacation videotape. The vacation setting in our example is Hawaii. If 
you haven't been there yet, perhaps this tutorial will provide you with a good 
excuse to go. 
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STARTING A SCRIPT 

..,.. 1. Load VCR Companion into your computer. 

See "Starting Up the Program" on page 6 if you need instructions on this 
procedure. 

A title sequence will appear on screen followed by the Main Menu with its 
three options . 

..,.. 2. Select Make a Video. 

This selection brings you to the Edit Script screen. This screen will always 
be your starting point for creating a VCR Companion video production. 



~ 3. Select Add. 

The Add menu contains all the elements for making a "video script." VCR 
Companion uses the "clapboard" on left side of the screen to list the 
elements that will be incorporated into your video script. The elements will 
be listed according to their order of occurrence. If you have more elements 
than can fit on the visible portion of the screen, click on the arrow bar above 
or ,below the clapboard to scroll through the script. 

~ 4. Select Background. 

Now you're ready to choose the type of background you want for your video 
titles . Backgrounds are your starting point for creating a video script. They 
serve as a backdrop over which other script elements (such as text , bor
ders, icons and animations) will be placed. 



Since we're doing titles for a Hawaiian vacation video, let's select an island 
Picture for our background. 

~ 5. Select Picture. 

The Picture menu that appears is typical of option menus that you'll en
counter throughout VCR Companion. 

~ 6. Select Change. 

By selecting Change, you will see a listing of the background pictures 
available on the VCR Companion disk. To see a representative sample of 
each multicolored background, please refer to your Reference Card. 

~ 7. Select Palms . 

We'll select Palms to establish a Hawaiian motif right here at the beginning 
of the footage. 

By selecting Preview on the Picture menu, you can view your selection 
before adding it to your script. 

By selecting Revert you can revert back to the selection that was made the 
last time you used the Picture menu. If you try this, however, be sure and 
reselect Change and Palms before continuing with this tutorial. 

~ 8. Select OK. 

After you select OK the Edit Script screen will reappear. If you look at the 
script, you'll notice the word "Palms" has been added to the first line of the 
script along with a graphic icon composed of a tree and a seagull. This 



clapboard icon denotes a Background and is there to remind you of the type 
of element that "Palms" represents. 

Note: For a representative sample of each of the clapboard icons, please refer to 
the Appendix of this manual. 

ADDING A BORDER 
Now let's add the "Photo" border to our Palms background. 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Border. 

~ 3. Select Change. 

~4. Select Photo. 

You will see a section of the Photo border in the Change window. If you'd 
like to see what this border will look like on a full screen, select Preview 
now. 

~ 5. Select OK. 
After you select OK the Edit Script screen will reappear. If you look at the 
script, you'll notice the word "Photo" has been added to the second line of 
the script along with a "Border" icon. 

ADDING TEXT 
Now we'll add text to our title. 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Text. 

A menu will appear allowing for selection of "static text" (stationary) or 
scrolling text. 



~ 3. Select Static Text. 

The Text menu will appear with various text options. 

~ 4. Select Font. 
A list of "font" or typestyle names will appear. 

We'll select the Pen font for our text. A representation of the font will 
appear in the font box. 

Note: To see a representative sample of each font, please refer to your Refer
ence Card. 
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..,.. 5. Select Pen. 

The color option defaults to white for the text. This is indicated by the 
white color bar next to the Color button. This color is fine for our purpose, 
so we'll skip this for now. 

Now we'll position the text. Since the palm trees are on the left in our 
background, let's position the text on the right side of the screen . 

..,.. 6. Select Position . 

..,.. 7. Select Right. 

And finally, we'll actually write the titles for our video script. 

..,.. 8. Select Add Text. 

This will take us to the Add/Edit Text screen where we can begin writing. 



~ 9. Position the pointer on the top line and press Return or press the mouse or 
joystick button. 

~ 10. Type: OUR 
HAWAIIAN 
VACATION 

pressing Return after each word to have them appear on separate lines . 

~ 11. Press the Esc key or click the mouse button. 

This will exit the text-writing mode and bring back the pointer so you can 
move freely around the screen. 

We next want to insert a blank line above our text to better position it 
vertically on screen. 

~ 12. Select Insert from the Add/Edit Text screen. 

~ 13. Position the pointer on the same line as the word "Our" and press Return 
(or click the mouse button). 

This will insert a line above the word "Our." This completes our text entry 
and we can exit the Add/Edit Text screen. 

~ 14. Select Done. 

And to return to the Edit Script screen, 

~ 15. Select OK on the Static Text menu. 

PREVIEWING YOUR WORK 
Let's preview what we've done up to now. 

~ 1. Select Preview from the Edit Script screen. 

On-screen prompts will appear requesting that we indicate the starting 
point and ending point of the preview. If a script is quite long, this gives you 
the option to view just a specific portion of it. However, we want to view 
everything we've done up to this point, so we'll select the entire script. 

~ 2 . Position the pointer on the first line of the script, "Palms," and press Return. 



~ 3. Position the pointer on the last line of the script, "Our," and press Return. 

A preview of the script will now appear on screen. 

Note: With some video scripts a prompt may appear requesting that you insert a 
different disk side before or during the preview. 

After you've admired your work for a sufficient amount of time, press any key to 
continue as the on-screen prompt indicates. 

When you wish to preview an entire video script, there is actually a more conve
nient way to do it than the method described above. Simply follow the two-step 
procedure outlined below. 

~ 1. Select Done from the Edit Script screen. 

The Record Video menu will then appear on screen. This is the menu that 
you will eventually use to record your video scripts on videotape or on a 
self-booting FilmDisk. 

~ 2. Select Preview Script. 

Now sit back and enjoy while the video script plays all the way through. The 
script will appear on screen exactly as it will when you record to tape or 
make a FilmDisk, except that the swap disk prompts are much less intrusive 
when recording. When you're finished previewing the video script, press 
any key to continue. To return to the Edit Script screen and continue with 
the tutorial, select Edit Script from the Record Video menu. 

ADDING A PAUSE 
The palm trees that we've added to our video script are kind of nice. To keep them 
on screen a little longer when the script is actually running, let's add a pause. 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Control. 

~ 3. Select Pause. 
The Pause menu that appears allows you to select the desired Amount or 
length of your Pause. The Amount defaults to Short which is what we desire. 

~ 4. Select OK. 

ADDING A SECOND BACKGROUND 
The graphic elements we've added up to this point have all been used over one 
background, as you could see from previewing the script. Let's add a second 
background as our next "frame" and add some additional titles to it. 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Background. 

~ 3. Select Color. 

This takes you to the Background Color menu. The default background 
color is black. This is indicated by its appearance in the color box next to 
the Change button. The currently selected color will always appear in this 
box. However, we want a dark blue color. 



.... 4. Select Change. 

This brings the Color Palette on screen. Now the default color is indicated 
by the white rectangle surrounding the black square. This white rectangle 
will surround any color that is currently selected . 

.,.. 5. Select the dark blue color square (second from the bottom on the left of the 
palette) by positioning the pointer over that color and pressing Return. 

.... 6. Select OK on the Background Color menu. 

The Edit Script screen will reappear. Notice that each element we add to our 
script appears on a separate line of the clapboard with its own distinct icon. 

ADDING TEXT TO THE SECOND BACKGROUND 
Now we want to add the date of our trip against this second background. This 
time we'll create yellow text to go against our dark blue background. We'll also 
center the text on screen . 

.,.. 1. Select Add from the Edit Script screen . 

.,.. 2. Select Text. 

.,.. 3. Select Static Text. 

.,.. 4. Select Font. 

.,.. 5. Select Bold . 

.,.. 6 . Select Color. 

This brings the Color Palette on screen again, this time with a white default 
color . 

.,.. 7. Select the yellow color square in the color palette (second from the top on 
the right side) . 

.,.. 8. Select Position . 

.,.. 9. Select Centered. 



.... 10. Select Add Text. 

..,. 11. Position the flashing text cursor on the third line from the top by using 
either the down arrow key or clicking on that line with the mouse . 

.... 12. Type: August 9, 1988 . 

..,.13. Press the Esc key to end the text entry . 

.... 14. Select Done . 

..,. 15. Select OK from the Static Text menu. 

PREVIEWING YOUR WORK 
Let's preview our video script again to see what we've done so far . 

..,. 1. Select Done from the Edit Script screen . 

.... 2. Select Preview Script. 
When you're finished previewing the video script, press any key to continue. 

To return to the Edit Script screen and continue with the tutorial, select 
Edit Script from the Record Video menu. 

DELETING AND ADDING TO THE VIDEO SCRIPT 
After you preview your video, you may want to add some final touches. For 
example, after the "Our Hawaiian vacation" title screen that we've made in this 
tutorial, let's add a little motion with a right-to-left airplane animation instead of 
the pause . 

..,.1. Select Delete from the Edit Script screen. 

At the top of the screen a prompt will appear asking, "Delete which item?" 

.... 2. Position the pointer on the fourth line of the script, which contains the 
"Short" Pause, and press Return . 

.... 3. Select Insert. 
At the top of the screen a prompt will appear asking, "Insert item where?" 

.... 4 . Position the pointer on the fourth line of the script and press Return. 

.... 5. Select Animation from the menu that appears . 

.... 6. Select Change . 

..,.. 7. Select Plane. 

Notice that the Animation menu offers two options in addition to Change. 
The Type option allows you to have the animation remain stationary on the 
screen, or move across the screen from right-to-left or left-to-right. The 
default setting is "right-to-left" which is just right for our purposes, so we'll 
leave it. The Speed option allows you to set a slow, medium or fast speed 
for the animation. The default setting is Fast and we'll leave that setting the 
way it is also . 

.... 8. Select OK. 

This brings us back to the Edit Script screen. Notice that the animation 
we've inserted now appears on the fourth line of the video script. 



EDITING VIDEO SCRIPT ELEMENTS 
A video script element can be edited or modified at any time. Simply select that 
element on the Edit Script screen and the appropriate options menu will appear. 

PREVIEWING THE COMPLETE VIDEO SCRIPT 
Let's preview the completed script. Now you'll really notice the spectacular 
results you get with VCR Companion! 

~ 1. Select Done from the Edit Script screen. 

~2. Select Preview Script. 

When you're finished weviewing the video script, press any key to continue. 

RECORDING YOUR VIDEO SCRIPTS 
You are now ready to record your video script onto videotape or a FilmDisk. 
Please tum to the next sections in this manual, "Using Your VCR" and "Making 
FilmDisks ." 



USING YOUR VCR 

This section is divided into two parts: "Connecting Your VCR" and 

"Recording Your VCR Companion Video Scripts." 

The information in this manual is presented with the assumption that you 

know how to operate your VCR properly. If you have any questions regarding its 

use, please consult the manual that came with your VCR. 

CONNECTING YOUR VCR Connecting your VCR to your computer is quite easy. 

Your VCR must receive the same information your monitor does, and should be 
connected to the composite monitor port on your Apple II or IIGs computer. 

A cable witli an RCA-type jack at either end will be needed to make the connec
tion. It is the same type of cable that is used to connect your composite monitor 
to your computer. 

Simply follow the step-by-step instructions below to make this easy hook-up. 

@ 
RCA Cable 

@ 
Composite Mon itor 

Port/Video Out 

COMPUTER 

@ @ 
Video Video 

In Out 

VCR 

.,. 1. Locate the "Video In" and "Video Out" ports on your VCR. 

TV 

Whatever format or brand of VCR you're using, there are various ports on 
the back of the machine. The two most important ones for connecting your 
VCR to your computer are Video In and Video Out. (On some machines , 
one or both of these may be located in the front.) 

.,. 2. Locate the Composite Monitor Port on your Apple. 

Your Apple computer has a port on the back panel that's used to connect the 
computer to a composite monitor. (Look for the TV symbol, not the 
RGB symbol.) Rather than use this port to connect your monitor as you 
normally would, you will now use it to connect the computer to the VCR . 

... 3. Using an RCA cable, conne.ct the Apple Composite Monitor Port to the 
"Video In" port on your VCR. If you are already using a composite monitor 
simply use the same cable. 

This connection will now enable the VCR to record all the output of your 
computer, which is everything that would normally be displayed on your 
computer monitor. 



RECORDING YOUR 
VCR COMPANION 
VIDEO SCRIPTS 

You'll also want to be able to view what the VCR is recording from your 
computer. If your VCR is already connected to your television, you 
are ready to go directly to Step 6 below. 

Otherwise, you can connect the VCR directly to your computer 
monitor by following Steps 4 and 5 below. 

~ 4 . Connect the "Video Out" port of your VCR to the "Video In" port of your 
computer monitor by using another RCA cable. 

\ 

If you want to hear as well as see your videos on playback, you will need to 
make an audio connection also. This is an optional connection since VCR 
Companion itself does not generate any sounds. 

~ 5 . Connect the "Audio Out" port of your VCR to the ''.Audio In" port of your 
computer monitor with another RCA cable. 

Not all computer monitors will have an ''.Audio In" port. If yours does not, 
and you want to hear audio on playback, you will need to connect your VCR 
to your television in the same manner you normally would. 

~ 6. Switch your VCR to Line (if applicable). 

Most VCR's have a switch to select video input either from the Tuner or 
from another input usually called "Line ." This should be set to Line. See 
your VCR Owner's Manual for details. 

Once you've connected your VCR to your computer system (see "Connecting 
Your VCR") , you are ready to record your VCR Companion video scripts. 

RECORDING 
When you begin recording, your VCR will completely record over anything that is 
currently on the videotape. It will replace any image that already exists - it 
cannot add to it. Anything you create with VCR Companion will be the only thing 
on that section of videotape where you record. 

Note: It is possible to overcome this hardware limitation by using an add-on 
"Genlock" board. Genlock boards allow you to overlay your video script onto an 
existing image. See a Genlock board Owner's Manual for a detailed description 
of how this board is used. 

BEFORE YOU BEGIN 
Before you begin recording it's a good idea to determine the total running time of 
your VCR Companion video script. This is especially true if you're inserting the 
video script onto a videotape and you want to avoid recording over too much of 
the existing footage. 

By selecting Preview Script from the Record Video screen, you can both examine 
your work and time its duration. You should add 1-2 seconds to the actual running 
time to allow for the mechanical starting and stopping of your VCR. This is 
especially true of older VCRs. 
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TO BEGIN RECORDING: 

.,... 1. Prepare your video script. 

.,... 2. Select Done on the Edit Script screen. 

The Record Video menu will appear on screen . 

.,... 3. Select Preview Script. 

It's always a good idea to preview your video scripts before you record 
them. This not only lets you view your completed work, it also lets you 
know of any disk swaps that may be necessary during the recording session. 

VCR Companion always loads as much of your video script into available 
memory as it can. However, if your scripts are long and have lots of different 
elements in them, the program might have to access the disk drives one or 
more times during a rec9rding session. This will require a disk swap if your 
video script calls for graphic elements that are stored on different sides of 
the program disks or on a number of different data disks. Otherwise VCR 
Companion will automatically search for and retrieve the necessary ele
ments with no action on your part. 

The prompts that appear on screen to signal a disk swap during 
Preview differ from those that appear during an actual recording 
session. The recording session prompts are much less intrusive as 
you will see below. ' 

.,... 4. Press the Esc key, the mouse button or the joystick button to end the 
Preview . 

.,... 5. Select Record On Tape . 

After you select Record On Tape from the Record Video menu, a prompt 
will come on screen which allows you to choose how you will be prompted 
for a disk swap during the recording session, should a swap be necessary. 

-------- ---------
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You may choose an audio prompt, a simple on-screen visual prompt or both. 

The audio prompts will signal you in the following way: 

You Hear: 

one beep 
two beeps 
three beeps 
a four note tune 

Insert into the Disk Drive: 

VCR Companion Side 1 
VCR Companion Side 2 
VCR Companion Side 3 
VCR Companion Side 4 or an entirely different data disk 

The on-screen prompts will appear in the extreme lower-left hand comer of the 
screen. They will appear as either a single number representing the appropriate 
disk side, "1" for Side 1, "2" for Side 2, "3" for Side 3 or the letter "O" (for 
"other") will appear to signal you to insert Side 4 or a separate data disk. 

After selecting the preferred prompt for a disk swap, the screen illustrated below 
will appear. 
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~ 6. Insert your videotape into the VCR. 

~ 7. Find the spot on the videotape where you want to add your VCR Compan
ion video script. 

~ 8. Press the Record button on your VCR and then quickly press the Pause 
button. 

Putting your VCR in "Pause" after pressing the Record button will give 
you the cleanest, most precise recording. 

~ 9. Select Begin Recording button on the VCR Companion screen. 

~ 10. Quickly press the Pause button on your VCR again so that it will begin 
recording. 

If you've followed Step 7 above, pressing the Pause button again will 
release your VCR from a state of paused recording and will begin recording 
your video script. 

~ 11. You will hear a short series oftones when the video script has played all 
the way through. 

Press the Pause button on your VCR when the video script has been 
completely recorded. 

~ 12. Press the Stop button on your VCR. 

~ 13. Press any key on your keyboard to return to the Record Video On Tape 
screen. 

A prompt will appear asking, "Would you like to run the video again?" 

~ 14. To return to the Record Video screen, select "No." 

A NOTE ON USING THE PAUSE BUTTON ... 
For technical reasons, the recording mechanism of some of the older VCRs may 
cause an unstable or jumpy image at the end of a recording insert. 

For example, let's say you've got a videotape of a friend's birthday. Midway 
through the birthday recording you wish to insert a scrolling message that you've 
created with VCR Companion. After doing this, you may notice a small section of 
unstable video at the end of the insert. 

If your VCR does cause this problem, its effect can be minimized by using the 
VCR's Pause button to finish recording each video script instead of simply 
pressing the Stop button. First you press the Pause button on your VCR at the 
end of a recording, then you press the Stop button. This recording method 
should minimize image instability after your inserted footage. 

You should try to avoid keeping your VCR in Pause for extended periods of time, 
as it may be somewhat wearing on the VCR's "video head." This presents no real 
danger to your equipment; many VCRs automatically jump out of Pause after a 
few minutes. The rule is: "Be Prepared" and anticipate your use of the Pause 
function. 

~\ 
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AUDIO DUBBING 
Some VCRs allow you to create an audio track on a separate audio channel. This 
is sometimes referred to as "dubbing." With this technique you can use a micro
phone or other audio input device to record audio without disturbing the existing 
video recording. Dubbing allows you to record voice-overs or music, for example, 
without recording over the existing video. If your VCR does not have the capabil
ity to audio dub and you try to record a sound source, the existing video image 
will be completely recorded over due to the workings of the VCR mechanism. 

Consult your VCR manual to determine if audio dubbing is possible with your 
machine. 

PLAYING BACK 
To see what you've recorded onto videotape from your computer, rewind your 
videotape back to the spot where you started recording your video script and 
then press the Play button on your VCR. 



MAKING FILMDISKS 

With VCR Companion you don't really need a VCR to create exciting 

video productions. You can also produce "FilmDisks" on standard 

computer floppy disks. FilmDisks are self-booting, so the disk that 

you use to create them must be dedicated solely to that purpose. In other words, 

the floppy used for the FilmDisk can store only one video script and cannot be 

used to store other data files. 

With a blank disk or a disk with expendable data, simply: 

~ 1. Complete your video script on the Edit Script screen. 

~ 2. Select Done. 

The Record Video screen will then appear. 

~ 3 . Select Make FilmDisk. 

The Make FilmDisk screen will appear with a prompt asking, "Which disk?" 
Insert your blank disk in a drive and press Change Disk. Select the desired 
data disk from the list of available disks and disk drives that appears. When 
a disk has been selected, the program will automatically format the disk. 

~ 4. Follow the on-screen prompts . 

VCR Companion will prompt you through the process of saving the video 
script as a FilmDisk and then prompt you to insert any necessary disks into 
your disk drive. 

Your finished FilmDisk will run by itself without VCR Companion being 
present or loaded. All that's needed to run the FilmDisk is an Apple Ile, Ile 
or IIGs computer. You can therefore send the FilmDisks to friends or family 
members as "computerized greeting cards" or present them to business 
acquaintances as messages about your product or service! 



WORKING WITH VCR COMPANION 

T he following Overview summarizes what was learned in the Quick Start 

tutorial section of this manual. If you haven't yet read that section, it 

would be best to do so now before continuing. 

AN OVERVIEW VCR Companion allows you to create a "video script" of graphic elements which 
you can then record on videotape or on a special FilmDisk you create with your 
computer. 

THE EDIT SCRIPT SCREEN 

The video scripts are created on the Edit Script screen illustrated below. 

Edit Ser-ipt 

You can add backgrounds, borders, text, animations, special effects, transitions 
and control elements and even complete Fantavision movies to these video 
scripts. You pick and choose the graphic elements for your video scripts from 
menus that appear on screen. 

You can also add Animate characters and Dazzle Draw pictures to your video 
scripts by first using the Convert Graphics utility built into VCR Companion. The 
procedure for doing this is outlined on page 42 of this manual under the heading 
"Convert Graphics Utility." 

Once you've selected and OK'd a graphic element, a short description of your 
selection will appear on the Edit Script screen along with an icon representing 
that selection. 

Note: A description of each icon can be found in the Appendix of this manual. 

The Edit Script screen contains all the following options and commands. Most of 
the commands - Add, Insert, Delete , Preview and Done - have been intro
duced in the Quick Start tutorial. 

Add Your starting point for creating video scripts. Allows you to add 
graphics, borders, text, animations, special effects, transitions 
and timing or control elements to your video script, in addition 
to Fantavision movies. 



Edit Allows you to edit any of the elements in your video script. 
Simply select Edit and then the element you wish to modify. 
Alternately, you may forego selecting Edit and simply select the 
appropriate item in the video script. Either action will return 
you to the Options window for that item, and you can make ~ 
your modifications. Remember, if you change your mind, simply ' 
select Revert to return the graphic element back to the state it ~ 
was in when you elected to modify it. ~ 

For some options like Background (picture, color, pattern, 
icon), you will only be able to change the second tier (e .g. , the 
particular picture choice) using Edit. To change from a picture 
background to a color background, for example, you must 
Delete the picture background from your script and Insert a 
color background in its place. 

Insert Allows you to insert an element into a script. When prompted 
to indicate where the insert should go, remember to select the 
script line that follows the desired insertion point. 

Delete Allows you to delete a video script element. When prompted, 
simply select the element you wish to remove. 

Clone Allows you to duplicate any graphic element in a video script. 
After selecting Clone, you will be prompted to select the 
element you wish to duplicate and the script line where you 
want the copy inserted. Remember that, as with the Insert 
command, you should select the line that follows the desired 
insertion point. 

New Clears the script you're currently working on so that you can 
start over. Selecting New will not erase a script that has been 
saved on disk. 

File Allows you to load Readymade video scripts that we've included 
with the program, save your work to disk and load video scripts 
that you previously saved to disk. You can also append or "link" 
video scripts together. 

Preview Allows you to preview your video script. Simply follow the 
prompts for selecting which portion of the script you wish to 
see. 

Done Select Done when you have finished with your video script. You 
will then be presented with additional options for previewing or 
recording your script. 

The Add and File commands are so important to the workings of VCR Companion 
that the next several pages of this manual will be devoted to their usage. 



THE FILE COMMAND READYMADES 
Rather than create a video script from scratch as described in the Quick Start 
tutorial, you can simply use one of the "Readymade" video scripts that came 
with the program. 

VCR Companion includes several professionally designed "Readymade" video 
scripts that include scripts appropriate for birthdays, vacations and school 
events. 

To use a Readymade video script: 

~ 1. Select Make a Video from the Main Menu. 

~ 2. Select File from the Edit Script screen. 

The File menu will now appear on screen. 

~ 3. Select Use a Readymade . 

~ 4. Select the desired Readymade from the list that appears on screen. 

VCR Companion will load the video script from disk and then the Record 
Video menu will appear on screen. 

You can then Preview, Record to Tape or Make a FilmDisk. 

If you wish to customize the Readymade, select Edit Script on the Record Video 
menu and then select the elements within the script that you wish to modify. 

SAVING VIDEO SCRIPTS 
VCR Companion follows the ProDOS conventions for the hierarchical filing of 
data. A single unit of saved data (e.g. one video script) is referred to as a "file." 
Files may be gathered together into "folders." A data disk can have any combina
tion of files and folders on it. If you are unfamiliar with these concepts, you may 
want to read "VCR Companion and ProDOS" in the Appendix of this manual. 

When you wish to save a video script you've created, simply: 

~ 1. Select File from the Edit Script screen. 
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~ 2. Select Save Script. 

The Save Script screen will appear. 

You will first be prompted to select the desired data disk from the list of 
available disks and disk drives that appears. When a disk has been selected, 
its name will appear on the first line of the file window. If there are folders 
on that disk, they will then be listed in the window below. 

When you select a folder, it will display a list of all the files it contains and 
the folder name will be displayed beneath the disk name. 

Note: If you need to format a data disk, you will need to first select Format Disk 
and follow the prompts . You may then continue on to Step 3 and proceed. 

~ 3. Select Enter Name. 

~ 4. Enter a file name for the video script and press Return. 

Your video script will now be saved and you will automatically return to the 
Edit Script screen. 

Note: The instruction to enter a file name in Steps 4 and 5 assumes that you are 
saving a video script for the first time. If you are only saving modifications to a 
video script you previously saved, simply select that video script filename from 
the list that appears in the file window. You will be warned that you are about to 
replace or "overwrite" the existing file, which is what you want to do if you are 
saving modifications to it. 

The Save Script screen also contains the following disk and file management 
utilities for your convenience. After selecting any one of them, you will be 
prompted on how to proceed. 

Change Disk Allows you to select a different disk drive or insert a different 
disk. 

New Folder Creates a new folder on the disk (volume) that is currently 
selected. 



Close Folder Closes whatever folder is currently open. 

Format Disk Formats a ProDOS disk. 

Delete Deletes (erases) a file from the currently selected disk. Will not 
delete locked files, entire volumes or folders with files in them. 

LOADING A SCRIPT 
The Load command will load any video script you've saved on disk. The proce
dure used to load scripts is identical to the one used to load other files, such as 
when you select From Other Disk from a menu. 

~ 1. Select File from the Edit Script screen. 

~ 2. Select Load Script. 

The Load Script screen will appear. 

You will first be prompted to select the appropriate data disk from the list of 
available disks and disk drives that appears. 

~ 3. Select the data disk on which you've saved the desired video script. 

When a disk has been selected, its name will appear on the first line of the 
file window. All the folders that are on that disk will be listed in the window 
below. When you select a folder, it will display a list of all the files it contains 
and the folder name will be displayed beneath the disk name. You then 
simply select the file which represents the desired video script. 

If you wish to change disks, select Change Disk. If you wish to close a 
folder and reverse your path through the filing system hierarchy, select 
Close Folder. 

~ 4. Select the video script you wish to load. 

The script will now be loaded and you will automatically return to the Edit 
Script screen. 



APPEND SCRIPT 
The Append Script command allows you to append or "link" separate video 
scripts together creating one script. To create one linked video script, start with 
the script you have in the clapboard (the script to which you want to append a 
script which has already been saved). 

~ 1. Select File from the Edit Script screen. 

~ 2. Select Append Script. 

The Append Script screen will appear. 

~ 3. Select the data disk on which you've saved the desired video script. 

When a disk has been selected, its name will appear on the first line of the 
file window. All the folders that are on that disk will be listed in the window 
below. When you select a folder, it will display a list of all the files it contains 
and the folder name will be displayed beneath the disk name. You then 
simply select the file which represents the desired video script. 

If you wish to change disks, select Change Disk. If you wish to close a 
folder and reverse your path through the filing system hierarchy, select 
Close Folder. 

~ 4. Select the video script you wish to append to the one already in the clapboard. 

The script will now automatically be appended to the end of the script in the 
clapboard. 

THE ADD MENU Selecting Add from the Edit Script screen allows you to access individual ele
ments that you can include in your video script. 

After you select Add, the Add menu will appear on screen. 



We've already looked at many of the Add menu items in the tutorial "Your First 
Video Script," included in the Quick Start section of this manual. We've looked at 
Background, Border, Text, Animation and Control. 

The Background and Control selections, however, contain important options not 
covered in the Tutorial, so we will examine those options now. 

The Add menu items we haven't looked at are: Transition, Special Effect and the 
Movie selection which allows you to add Fantavision movies to your video 
scripts. 

BACKGROUND 
Backgrounds, in general, are your starting points for creating video scripts . 
Other elements such as text, borders and animations will be displayed over these 
backgrounds. There are four different types of backgrounds : pictures, solid 
colors, patterns and icons. The first three are "full screen." Icons, however, are 
not full screen and can be placed in different, selectable locations. 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Background from the Add menu. 

From the menu that appears you may now select a background type: 
full-screen picture, full panel of color, background pattern or background 
icon. 

We have already examined the Picture and Color options in the Getting Started 
tutorial, so let's take a look at Patterns and Icons. 



Pattern 
Selecting Pattern from the Background menu will bring up a familiar options window. 

By selecting Change you can view the complete list of of available patterns and 
select the one you desire. 

Icon 
Icons are graphics that can be placed at selectable locations on screen. 

After selecting Icon from the Background menu, you may select Change in the 
usual manner to view a list of available graphics. 

When you have selected the desired graphic, select Position to position the 
graphic on screen. Then, select one of the nine possible positions for it. 

The position you select will be indicated by a yellow highlight around it. 



Note: To put more than one icon on screen, you can select Clone from the Edit 
Script screen and then edit the copies to change their position. Or, you can add 
additional background icons one at a time by selecting Add from the Edit Script 
screen and then adding icons in different on-screen positions . 

CONTROL 
The Control option in the Add menu allows you to: instruct your video script to 
await a keypress before continuing to the next element, repeat a series of 
graphic elements in your video script or add pauses. 

Starting from the Edit Script screen, 

.,.. 1. Select Add from the Edit Script screen . 

.,.. 2. Select Control. 

The Control window will appear on screen. 

You now have three choices: Pause , Repeat Items and Wait for Keypress . 



Pause 
Select Pause to add a pause to the end of your video script, as you did in the 
tutorial. The Amount option in the Pause window allows you to select a Short, 
Medium or Long pause. 

Repeat Items 
Select Repeat Items to repeat a sequence of elements that currently exist in 
your video script. After selecting Repeat Items, a window will come on screen 
with two options. 

Amount Allows you to select the portion of your script you want re
peated. After you select Amount, the Edit Script screen will 
appear with a prompt asking, "Repeat from where?" Simply 
select the first item you want repeated. All elements from that 
item to the Repeat Item will then be repeated. 

Reps Allows you to select the number of repetitions you want the 
repeated items to cycle through. After you select Reps, a menu 
will appear giving you the option of having 1,5, 10 or an infinite 
number of repetitions. If you select Infinite, remember that you 
can stop the repetition in preview or record by pressing the 
Esc key or Return. 

Wait for Keypress 
Wait for Keypress allows you to instruct the video script to wait for a keypress 
before displaying the next element in the script. At the Wait for Keypress window 
you have two options. You can either have a prompt displayed on screen as a 
guide to continue the script or not incorporate a visual prompt at all. 



TRANSITION 
Transitions give you a special way of blending one graphic element of your video 
script into another, rather than just having them pop on and off screen. 

There is a wide selection of transitions available on VCR Companion. 

To add a transition to your video script: 

~ 1. Select Add from the Edit Script screen. 

~ 2. Select Transition. 

The Transition window will appear on screen. 

~ 3. Select Change. 

A menu of possible transitions will appear on screen 

~ 4. Select the desired Transition. 

~ 5. Select Speed from the Transition window. 

A menu will appear giving you the option of having slow, medium or fast 
transitions. 

~ 6. Select Slow, Medium or Fast. 
The transition you selected will appear next to Change in the Transition 
window. The speed you selected will appear next to Speed. 

You may now select Preview if you wish to view the transition, or Revert if you 
wish to revert back to the last transition selected when you opened the Transition 
window. 

~ 7. Select OK when you want to keep the selected Transition and Speed. 

You will now automatically return to the Edit Script screen, and your 
transition will be marked on your video script. 

Note: In general you must have a graphic element before or after the transition 
in order for the transition to have any effect. Transitions like "Mask" are excep
tions where you must have a graphic element both before and after in order to 
have the proper effect. 
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You may also design custom transitions by using the Transition Editor, which can 
be accessed by selecting Utilities from VCR Companion's Main Menu. Complete 
instructions for using the Transition Editor can be found in the next section of 
this manual under the heading "Utilities." 

SPECIAL EFFECT 
VCR Companion includes a number of Special Effects you can add to backgrounds 
or individual graphic elements in your video script. 

To add a Special Effect to your video script: 

~ 1. Select Add from the Edit Script screen. 

~2. Select Sp.Effect. 

The Special Effect window will appear on screen. 

~3. Select Change. 

A menu of possible Special Effects will appear on screen. 

~4. Select the desired Special Effect. 

~5. Select Speed from the Special Effect window. 

A menu will appear giving you the option of having slow, medium or fast 
Special Effects. 

~6. Select Slow, Medium or Fast. 

The name of the Special Effect you selected will appear next to Change in 
the Special Effect window. The speed you selected will appear next to 
Speed. 

You may now select Preview if you wish to view the Special Effect , or 
Revert if you wish to revert back to the last Special Effect selected when 
you opened the Special Effect window. 

If you want to keep the selected Special Effect , 

~7. Select OK. 

You will now automatically return to the Edit Script screen, and your Special 
Effect will be marked on your video script. 



MOVIES 
VCR Companion allows you to include movies in your video scripts that you 
create with the Apple II version of Fantavision, an animation program from 
Br0derbund. 

Note: You cannot import movies created with the Apple IIGS version of Fantavi
sion because it uses a different picture format than does the Apple II version. 

First you must create the movies and save them on disk as described in the 
Fantavision User's Manual. 

Then, to bring your movie into VCR Companion: 

.,.. 1. Select Add from the Edit Script screen . 

.... 2. Select Movie. 

The Movie window will appear on screen . 

.... 3. Select' Change. 

The on-screen prompts will now instruct you on how to select the approp
riate data disk from the file window that appears. The procedure is identical 
to the one used to load video scripts that is outlined on page 31 under 
"Loading a Script." 

Note: The special keyboard commands available with Fantavision will be 
deactivated when a Fantavision movie is used within a VCR Companion 
script. 



UTILITIES 

V CR Companion contains several utility programs that enable you to 

design your own transitions and import graphics from other programs. 

The Transitions that you can design with the Transition Editor may be as 

simple or as elaborate as you desire. 

The graphics that you can import with VCR Companion's Convert Graphics 
utility fall into two basic categories: 

• Any full-screen "double-high resolution" picture . 

• Any animation "character" created with Br0derbund's own Animate software . 

To use these Utilities you must begin at the Main Menu. If you are in the Edit 
Script screen, select Done first, and then select Main Menu from the Record 
Video screen. Then, select Utilities and the Utilities screen will appear. 

From this point you may elect ,to use either the Convert Graphics utility or the 
Transition Editor. · 

THE TRANSITION EDITOR With the Transition Editor you can design the visual pattern used to change from 
one graphic element or frame to another in your video script. You can control the 
speed of your Transition at any specific point. And you can insert pauses. 

~ 1. Select Utilities from the Main Menu. 

~ 2. Select Transition Editor from the Utilities menu. 

The Transition Editor screen will then appear. 
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~ 3. Select Edit. 
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The Transition Editor presents you with a rectangular area composed of 
small squares . This area represents your computer screen. By selecting 
the small squares, in any desired order and pattern, you will create the 
visual pattern of the transition. 
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~ 4. Select the small squares to create your transition. 

The squares can be selected with a mouse by either pointing and clicking on 
individual squares or by dragging the mouse over any number of them. 

If you are using a keyboard, you may select the squares one at a time by 
first positioning the highlighter with the arrow keys and then pressing the 
Return key or Spacebar. 

Whatever your method of selecting the squares, you may use the Delete 
key to back up and undo your selections. 
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CONVERT 
GRAPHICS UTILITY 

~ 5 . Select the Pause and Speed buttons to control the rate of your transition. 

The Pause and Speed buttons may be selected with the mouse or by using 
the arrow keys. If you are using the arrow keys, simply direct the highlighter 
down to the buttons , where the highlighter will tum into the pointing hand. 

After you select either Pause or Speed, a menu will come on screen pre
senting the options for each command. Simply make your selection from 
these menus. 

~ 6 . Select Done when you are finished designing your transition. 

This will return you to the main Transition Editor screen. You may now 
select one of the following commands: 

Edit Allows you to go back and modify your transition. 

Revert Allows you to revert back to the transition that was present 
before you made any modifications . 

Clear Erases any transitions currently shown on screen so that you 
can start over. 

Preview Lets you Preview your work with a choice of using the edit grid 
or the full screen. 

Load Lets you load in other transitions that you previously designed 
and saved to disk. After you select Load, a screen will appear 
that is identical in appearance and operation to the Load Script 
screen described on page 31 of this manual. Please tum to that 
page if you need any instruction on the loading procedure. 

Save Lets you save to disk any transition you've created with the 
Transition Editor. After selecting Save, a screen will appear 
that is identical in appearance and operation to the Save Script 
screen described on page 30 of this manual. Please tum to that 
page if you need any instruction on the saving procedure. 

Done Returns you to the Utilities menu. 

With VCR Companion's Convert Graphics utility, you can convert graphics files 
from other programs for use in your VCR Companion video scripts. You can 
convert Double High-Resolution pictures from programs like Br0derbund's 
Dazzle Draw for use as background pictures . And you can convert "character" 
files created with Br0derbund's Animate program to create your own animations 
or icons . 

~ 1. Select Utilities from the Main Menu. 

~ 2 . Select Convert Graphics. 

The Convert Graphics menu will appear. 



.,.. 3. Select either Double Hi-Res picture or Animate character. 

After making either of these selections a loading screen will appear that is 
identical in appearance and operation to the Load Script screen described 
on page 31 of this manual. Please turn to that page if you need any instruc
tion on the loading procedure . 

.,.. 4. Select the Double Hi-Res picture or Animate character you wish to convert . 

.,.. 5. At the "Which disk?" prompt, select the destination for the file to be 
converted . 

.,.. 6. Enter the name for the converted file. 

When you press Return, the conversion process will start automatically and 
save the new file to disk. 

In very rare instances, VCR Companion may be unable to convert the file 
you have selected. This may happen if you attempt to convert a picture or 
Animate character that is too complex. 

If this happens, you will have to simplify the picture using the program that 
created it, and then attempt the conversion process again. 

If you are converting an Animate character, you will also need to select the 
type of file you want to convert the character into, Animation or Icon. If you 
select Icon, VCR Companion will take the first frame of the character as the 
Icon image, disregarding any other frames . 

Animate Characters 
A few notes on designing Animate characters for use with VCR Companion: 

• Black areas in your icons or animations will become transparent in a VCR 
Companion video script. That is , any image that was on the screen before will 
show through the black areas of an icon or animation overlaid on top of it. 
Keep this in mind when creating or modifying characters to be used with VCR 
Companion. 



• Animations must be no more than 16 frames long and must be no larger than 
100 x 100 screen pixels . VCR Companion may reject your file stating that it 
has too many frames or that the total data in the frames exceeds its limits. In 
that case you will need to go back and simplify the animation. 

• You can also use Dazzle Draw to create icons or animations and then import 
them into Animate using Animate's "Transfer Pie" option from its "File" menu. 
These icons or animations would then be imported into VCR Companion with 
the Animate character command. 

Using Converted Graphics 
You can incorporate converted graphics into a video script by simply selecting 
From Other Disk on the appropriate Background Picture, Background Icon or 
Animation options menu. The name of the file selected From Other Disk will be 
displayed in parentheses on the clapboard. 



CREATIVE IDEAS 

V CR Companion can be used in countless ways for your home, school or 

business needs. Here are a few ideas to get you started. 

PRODUCTION IDEAS TITLES 

USING VCR COMPANION 
WITH VIDEOTAPES 

Add titles to videos of any event you'd like to preserve. For instance: "Our 
Wedding," "Mom and Dad's 50th Anniversary," "Winning the Bowling Tourna
ment," "Muffy Graduates," "Hawaiian Adventures," etc. 

CREDITS 
Name the stars in your videos. Give credit for Producer, Director, Camerawork, 
Editing, Script and of course Graphics and Titles! 

INTRODUCTIONS 
Set the scene or explain what happened to make everyone look so surprised. 

INTERMISSIONS 
Giving a long show? Include an intermission spot. Add a little humor or "mock 
up" a cartoon of what will be shown. 

ENDINGS 
Polish your video by using VCR Companion to generate some concluding footage. 
Add a postscript. Add credits at the end. 

STUDENT REPORTS 
Use video footage and VCR Companion graphics to create an audio/visual 
presentation well worth an A+ ! 

"VIDEO LABELS" 
Make on-screen "videolabels" to identify all your odds and ends of tapes (When 
did we shoot this? Where was it? Who's holding the baby? Why does everyone 
look so happy?). 

MOVIE FEATURES 
Create movie features (kids love to do this!). Some ideas are: ''Attack of the 
Killer <fill in the blank>," "Dottie Loves Jim," "Star Battles," etc. 

MAKE YOUR OWN "SILENT MOVIES" 
For fun, add "Silent Movie"-style dialog screens to your videos. 

MAKE YOUR OWN DOCUMENTARIES 
Intersperse text and commentary with video shots of interesting events you 
witness. 

COMPILE "BEST OF" TAPES 
Using two VCRs, combine your best shots from tapes of events like Little 



USING VCR COMPANION 
FILMDISKS 

League games, tennis matches, school plays and other important family events. 
Introduce each clip with titles from VCR Companion. 

MAKE LESSON TAPES 
At school or at home, learning with video can be fun. And with VCR Companion, 
you can generate complete video sequences or you can introduce sequences 
taped with your video camera. Use it for French vocabulary drills, quizzing 
addition tables and more. 

SUBSTITUTE COMMENTARY FOR COMMERCIAL BREAKS 
Tired of watching commercials in your favorite taped football game? Insert 
commentary, wisecracks or graphics instead with VCR Companion. 

TV/FILM CRITIC 
Introduce your favorite films with your own humorous critiques ("Turkey of the 
Year Award," "The Film that Made an Actor Stand Tall," etc.). Say it with 
graphics or words. 

YEARBOOK/GROUP PORTRAIT 
Take a group portrait with your video camera, zooming in on each individual one 
by one. Edit with VCR Companion, identifying each group member by name, 
with or without graphics or captions ("The biggest smile in town," etc.). 

GIVE A TOUR 
Show them where you live or work. Make a video of your yard, garden, house or 
office with commentary and titles from VCR Companion. 

MAKE A HORROR FILM COLLAGE 
Using two VCRs, edit the scariest scenes from horror films and introduce each 
one with credits and titles made with VCR Companion. 

VIDEO GREETINGS DISKS 
Send greeting videos to friends and family members . They can pop the disk into 
their computer and see your handiwork! 

ANIMATED WINDOW DISPLAYS 
Create repeating advertisements for in-store and window displays. Add a Repeat 
Item to the end of your script, set Amount to include the entire video script and 
set Reps to Infinite. Now VCR Companion will continuously run the video script 
when you preview it. By making FilmDisks of this script you could send your new 
video advertisement to each of your novelty shops (or whatever!). Each store 
would have a computer and a monitor set up in its window to display your new 
video. Using VCR Companion in this way is comparable to one of the "Rolling 
L.E.D." displays commonly found in stores. VCR Companion, however, lets you 
use 16 colors, graphics, animations and all the other features of the program! 

ELECTION CAMPAIGN SPOTS 
Create your own repeating campaign message using the technique above to run 
on video monitors at campaign headquarters or wherever merchants or organiza
tions will donate space. 



APPENDIX 
MAxIMUM SCRIPT SIZE When you are creating your script, VCR Companion is doing much more than the 

eye can see. It will automatically try to keep as much of your script data around 
as it can. This translates as the actual image that makes up a specific Border or 
Pattern. Every computer has a limited amount of memory that it can use. Don't 
worry about it, though, because VCR Companion is able to recognize and work 
with the memory limits of your computer system. Once this intern.al memory is 
used up, the program will automatically load any data not known to it from disk, 
as needed. 

VCR COMPANION 
ANDPRoDOS 

Your script's maximum length can be anywhere from 64 to 170 items. The actual 
length depends on how many different elements you use in the script. For 
example, if you use a "Photo" border at one point in the script and then use it 
again further on, the program keeps the actual information for that border around 
only once, conserving memory. Also, the more text you use in the program 
(what you actually type in, not the items), the less space is available for keeping 
the other elements that make up your script. 

Whether you're recording on tape or creating a FilmDisk, the script length 
limitations are identical. 

This section is meant to be a quick guide to introduce you to ProDOS. It is not 
intended to be a substitute for the ProDOS User's Guide. 

ProDOS is the current standard disk operating system for the Apple II line of 
computers . If you are still using DOS 3.3 you may find some of the concepts in 
ProDOS a little unfamiliar. However, once you "take the plunge" and learn how 
this powerful operating system works , you will undoubtably find its advantages 
useful. 

Instead of having to refer to a disk as Slot 6 Drive 1, etc. , ProDOS lets you name 
each Volume or Disk. When you select Change Disk from the File menu, you will 
be presented with any sources available to you. 

Names displayed on screen next to the disk icons refer to the disks you have in 
your disk drives. Any disk listed as "Slots and Drives" means that either the 
drives have no disks in them or the disks in those drives are not formatted for 
ProDOS. Selecting one of the disk names that appear will tell VCR Companion 
that you wish to see the files or folders on the selected disk. The disk name is 
displayed on the first line, with the files or folders listed below. 

When you format a disk you are given the opportunity to name it what you wish. 
It is advisable to use a name that makes sense for what will be on that disk. 
Remember that when you format a disk you will lose all the information previously 
on it . If you try to format a disk that has something on it, VCR Companion will 
provide a prompt which gives you an opportunity to cancel or go on. If you do not 
wish to lose the information on the selected disk, select "No. " 

ProDOS gives you a file handling environment somewhat like that of the Apple 
Macintosh® computer. A single unit of saved data (e.g. a video script) is referred 
to as a "file." Files may be gathered together into "folders." Therefore, on your 
data disk, you can set up folders to put groups of files in. 



To put this into perspective, imagine your disk as a file cabinet. You can just 
throw all the letters, pictures and other files you create into one cabinet. How
ever, randomly throwing different files into the same cabinet would make it 
extremely hard to find a certain file . It is much easier to make folders for each 
type of file and then put those files into a folder. Finding a particular file is as easy 
as opening the folder and looking inside. You can even have folders within other 
folders. Within your Picture folder, for example, you can group the pictures into 
categories of Animals, People and Plants by creating sub-folders for each cate
gory and putting your files in the appropriate folders. This organizational capabil
ity is one of the most useful features of ProDOS. 

When you save or load files with VCR Companion you are able to take advantage 
of the ProDOS sub-folder capabilities. For example, on your data disk you could 
have individual folders for Background Pictures, Animations and Background 
Icons that you have converted. When you are in VCR Companion's Save Script 
menu you have the option to create a New Folder. The program will then ask you 
to name your new folder. Pressing Return without naming your new folder will 
cancel the operation. When you enter a name, your new folder will be created. In 
other words , when you are in a folder called "Pictures" and then create a new 
folder inside your "Pictures" folder called "Animals," you have created a sub
folder. VCR Companion automatically goes into the new folder, ready for you to 
save your file. 

A selected folder will open and display a list of all the files it contains. The name 
of the folder is displayed on the second line, above the file list. Remember that 
VCR Companion shows you only the folders and files you are looking for, regard
less of whether it is a load or save operation. For example, if you are loading a 
background picture From Other Disk, then you will see the background pictures 
available as well as any other folders contained on the disk. To back up and close 
a folder, use the Close Folder button. 

After selecting From Other Disk, VCR Companion will display what is on the 
current data disk. The first time you load a file by selecting From Other Disk 
VCR Companion will automatically ask you which drive or disk you want to 
access. Simply select the desired disk and the program will show you what files 
and folders are contained on it. You then simply select the desired file. Selecting 
the folder opens it to show you what files or sub- folders are inside. You can use 
the arrow buttons to the left of the file listing to scroll the list up and down to see 
all of the files or sub-folders you have in the folder. 

When you save a file, you can specify the file name in one of two ways. If you 
want a new file name, select Enter Name and type in the name you wish. VCR 
Companion will inform you if a file by that name already exists and then prompt 
you to either replace the existing file or cancel the operation. If you do not wish 
to replace the existing file , select "No" and enter another name. If you are mak
ing modifications to an existing file , you may simply select the correct file name 
from the file listing window. VCR Companion will prompt you that the file already 
exists and ask if you want to replace it. If you are making modifications to a file 
you would answer "Yes" to this prompt so that the previous version of the file 
will be replaced. Again, if you do not want to replace the existing file , select "No." 



MENUS AT A GLANCE 

MAIN MENU 

Utilities r----------~ 

Quit 

... > EDIT SCRIPT 
... ... 

I I I 

Background 
Border· 
Text------ 

Animation 
Transition 
Sp. Effect 
Control-~ 

Movie 
Cancel 

Background 

Picture 
Color 

Pattern 
Icon 

Cancel 

Control 

Pause 
Repeat Items 

Wait for Keypress 

Text 

Add 
Edit 

Insert 
Delete 
Clone 
New 
File 

Preview 
Done 

File 

Load Script 
Save Script 

Append Script 
Use a ReadyMade 

Cancel 

Done 

Record Video 
Preview Script 

Record On Tape 
Make FilmDisk 

Edit Script 
Main Menu 

Static Text 
Vertical Scrolling Text 

Horizontal Scrolling Text 
Cancel 

> > UTILITIES > > 
Transition Editor 
Convert Graphics 

Install Onto Hard Disk 
Main Menu 

Transition Editor 

Edit 
Revert 
Clear 

Preview 
Load 
Save 
Done 

Convert Graphics 

Double Hi-Res Picture 
Animate Character 

Done 
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Background Picture The file name of the full-screen picture will 
appear next to this icon. 

Background Color The color selected for the background will 
appear next to this icon. 

Background Pattern The name of the pattern will appear next to 
this icon. 

Background Icon The name of the background icon will appear 
next to this icon. 

Border The file name of the border will appear next to this icon. 

Static Text The first 12 characters of your static text will appear 
next to this icon . 

Vertical Scrolling Text The first 12 characters of your vertical 
scrolling text will appear next to this icon. 

Horizontal Scrolling Text The first 12 characters of your horizon
tal scrolling text will appear next to this icon. 

Animation The, name of the animation will appear next to this icon. 

Transition The name of the transition will appear next to this icon. 

Special Effect The name of the special effect will appear next to 
this icon. 

Pause The length of the pause, either "Short," "Medium" or 
"Long," will appear next to this icon. 

Repeat Items The number of script items to be repeated will 
appear next to this icon . 
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Wait for Keypress The word "Wait" will appear next to this icon. 

Fantavision Movie The name of the file will appear next to this 
icon. 



BACKUP DISK INFORMATION 

This program is copy protected. If you would like a backup disk, you may order one using the coupon below. 
You may do this at any time, as long as the product is still being manufactured by Br0derbund. 

Limit: one per customer. 

Please mail the original coupon, not a copy, along with a check or money order for $10.00 (in U.S. funds) , or 
complete credit card information to: 

Br0derbund Software-Direct 
P.O. Box 12947 
San Rafael, CA 94913-2947 

Please make your check or money order payable to Br0derbund Software. 

Backup Disk Coupon 
(Please print) 

Product Name: VCR Companion 

Format: (please check one) 

(required for credit card orders) 

D Apple 5.25-inch Disk D Apple 3.5-inch Disk 

Payment method: 
D Check/money order 0 VISA D MasterCard 

Credit Card Account Number 

Signature (required for credit card orders) 

D American Express 

Expires 

(Clip this coupon along the dotted line and send along with your payment. Please allow four weeks for delivery.) 
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ProDOS 47-48 
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WARRANTY 
BR0DERBUND'S LIMITED NINETY-DAY 
WARRANTY 

DISK REPLACEMENT POLICY 

LIMITATIONS ON WARRANTY 

Br0derbund warrants for a period of ninety (90) days following the original retail purchase 
of this copy of VCR Companion that the program is free from substantial errors or defects 
that will materially interfere with the operation of the program as described in the 
enclosed user documentation. This policy applies to the initial purchaser only. 

If you believe you have found any such error or defect in the program during the warranty 
period, call Br0derbund's Technical Support Department, 800/527-6263 or 415/492-3500 
between the hours of 8 a.m. and 5 p.m. (Pacific time), Monday through Friday. Br0der
bund technical personnel will attempt to help you correct or avoid the problem. If any such 
error or defect cannot be corrected or reasonably avoided by the customer, Br0derbund 
will inform you how to obtain a corrected program disk (or, at Br0derbund's option, 
Br0derbund may authorize refund of your purchase price). 

This warranty gives you specific legal rights, and you may also have rights which vary from 
state to state. 

If any disk supplied with this product fails within ninety (90) days of purchase for any 
reason other than accident or misuse by the customer, please return the defective disk 
together with a dated proof of purchase to Br0derbund Software-Direct, 17 Paul Drive, 
San Rafael, CA 94903-2101, for a free replacement. This policy applies to the original 
purchaser only. 

Br0derbund will replace program disks damaged for any reason, whether during or after 
the ninety (90) day free replacement period, for $5 per disk plus a postage and handling 
charge of $2.50 per request, as long as the program is still being manufactured by 
Br0derbund. 

Unauthorized representations: Br0derbund warrants only that the program will perform as 
described in the user documentation. No other advertising, description or representation, 
whether made by a Br0derbund dealer, distributor, agent or employee, shall be binding 
upon Br0derbund or shall change the terms of this warranty. 

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, BR0DERBUND MAKES NO 
OTHER WARRANTY, EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. BR0DERBUND 
DISCLAIMS ANY WARRANTY THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, 
AND ANY IMPLIED WARRANTY OF MERCHANTABILITY SHALL BE LIMITED TO THE 
NINETY (90) DAY DURATION OF THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE 
EXPRESSLY AND SPECIFICALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITA
TIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU. 

NO CONSEQUENTIAL DAMAGES: BR0DERBUND SHALL NOT BE LIABLE FOR SPECIAL, 
INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF BR0DERBUND IS 
ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT 
BR0DERBUND SHALL NOT BE RESPONSIBLE OR LIABLE FOR LOST PROFITS OR 
REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF TIME, 
DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE ACTUAL 
COST OF THE PRODUCT. IN NO EVENT SHALL BR0DERBUND'S LIABILITY EXCEED THE 
PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

The user of this product shall be entitled to use the product for his or her own use, but shall 
not be entitled to sell or transfer reproductions of the software or manual to other parties in 
any way, nor to rent or lease the product to others without the prior written permission of 
Br0derbund. 

For technical support, on this or any other Br0derbund product call 800/527-6263 or 
415/492-3500. 

©1988 Br0derbund Software, Inc. , 17 Paul Drive, San Rafael, California 94903-2101 
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